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Make a screencast on your mac or PC
Screencast-O-Matic (Mac or PC)
Screencast-O-Matic (www.screencastomatic.com) is a really great option for making screencasts 
using a computer.  It allows you to record up to 15 minutes, allows you to record your webcam 
video as well as your screen, allows publishing directly to YouTube and allows downloading in 
MP4 format.  Best of all, it’s cheap - or even free if you don’t want any bells and whistles.  

Start by dragging the handles on the marquee to define the area of the screen you want to capture. If 
you are recording your webcam, you will see the video window on your screen. If you prefer, you 
can record the entire screen. This is what you would do if you wanted to record a PowerPoint 
presentation, for example. 

Before you start recording, there are a few things to check.   

1. If you want to record your webcam as well as the screen of your computer, click on the “Both” 
button in the preferences pop-up (pictured below). You may need to select your webcam by 
clicking the small disclosure triangle beside “Webcam” in the little cameo video screen. The 
cameo video screen can be moved anywhere within the selected area of the screen if you don’t 
want it to be in the lower right.  

2. Check that in the preferences pop-up, the app is set to record using the microphone you want to 
use. To check this, click the disclosure triangle beside the microphone beside “Narration” in the 
preferences pop-up window. 

3. In the webcam cameo video window,  you will notice a small magic wand icon in the upper 
right. Clicking this gives you some very useful options. One is to flip the video horizontally, 
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which is very useful if you like to point at things on the screen. If you don’t flip horizontally 
you will find that you are pointing in the wrong direction! The other checkbox in the same 
window allows you to remove or ‘key out’ the background colour. You would use this if you 
have a green screen. 

Once you click the red ‘Record’ button, Screencast-O-Matic will give you a 3-second countdown 
and then start recording.  

While recording, the area of the screen that is being recorded will be framed with a red line.  Note 
that it is possible to pause the recording to move things into the red box, or even to resize the part of 
the screen that is recorded. 

To finish recording, press the blue pause button, then 
press “Done”. You are then presented with three options 
for what to do next. 

(A) You can choose “Save / Upload” to choose options 
for uploading your video to Screencast-O-Matic.com, 
YouTube or other services.  

(B) You can “Quick Share”. This will upload the video in 
the background to Screencast-O-Matic and immediately 
put a link to the video on your computer clipboard, so 
you can share the video even while it is uploading.  

(C) You can choose “Edit Video”. This allows you to do 
quite a few things such as: 

•  adding subtitles,  

• adding background music,  

• increasing or decreasing the speed of the video,  

• adding titles,  

• creating blur/focus areas. 

• importing other videos 

• cutting out sections of your recording. 

• turning off the cursor or webcam 

• adjusting the volume in parts of the recording 

• recording a narration over the top of the video 
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While I think Screencast-O-Matic hits the sweet-spot for most teachers in terms of price, simplicity 
and features, if you want instructions and details for one of the other tools, you can download them 
in PDF format from here: http://bit.ly/28-2-14 

Screencast-O-Matic Paid versions. 

The free version of Screencast-O-Matic is quite functional, but very basic. It lacks the ability to do 
all but the most basic editing, lacks the ability to use a green screen, and the ability to draw on the 
screen using built-in pen tools.  

There are two tiers of paid plans, which while they cost something are still very cheap in 
comparison to other comparable products.  

In addition to the above individual paid plans, you can also sign up as an institution. Depending on 
the number of computers you want to run it on, the pricing changes. The prices below are the prices 
for ten licenses. It gets relatively cheaper the more licenses you buy. 

Screencast-O-Matic   |  Screencast-O-Matic.com   |  Free or $15 per year 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Lessons in Their Pockets
Podcatchers 
It has never been easier to subscribe to educational podcasts.  Previously you had to subscribe to 
podcasts using iTunes on a computer and then sync or copy them to your mobile device for 
listening.   

There are numerous podcast catching apps available for Android and iOS operating systems, that let 
you download podcasts directly to your mobile device - most are either free or a few dollars.  A 
simple search in the relevant app store will yield a smorgasbord of choices. Universally these give 
you the ability to search for and subscribe to podcasts, choose how often you want it to check for 
new episodes, whether you want it to download new episodes as they become available, or only 
when you are connected to WiFi and so on.  They also usually offer the option to vary playback 
speed and to skip by various amounts of time (typically 30 seconds) forward or backward.  On 
iPhones and iPads, Apple’s “Podcasts” app is pre-installed.  It is a decent player with some 
advantages that are not found in other podcast apps - such as the ability to sync with iTunes and the 
ability to be controlled by Siri. Downcast is also really good if you want more granular control over 
how your podcasts behave (in terms of downloading, deleting finished episodes, and tweaking skip 
forward and backward controls, etc.) 

One of my favourite podcast catchers on iOS is Overcast.  What stands Overcast out from the crowd 
is its “Smart Speed” option, which shortens silences, which reduces the listening time, without 
changing the actual playback speed.  Ingenious!  It also has a “Voice Boost” function which is 
useful if you listen to podcasts that are not recorded using high quality equipment (ie. many amateur 
podcasts).  The Voice Boost seems to make such amateur podcasts sound fuller, as though the gain 
were increased.  This is not really useful on podcasts that have been recorded using high quality 
equipment.  

There are also many programs available for subscribing to and listening to podcasts on a PC or 
Mac.  The most obvious is iTunes.  
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For a More Polished Podcast
Audacity
If you want to make a really good quality podcast, including jingles and sound effects, Audacity is a 
free, open source, multi-track audio editor that is as good as you will find without spending a 
significant amount of money for a professional software package like Logic or Adobe Audition.  
Because it is very full-featured, the interface looks overwhelming to the uninitiated, but don’t let 
that put you off.  It’s actually quite easy to use once you get the hang of it. For a podcast, you really 
only need a handful of the available tools.  If you are not familiar with using an audio editor, I have 
prepared a 21 page document on Audacity which you can download separately from here:  

http://bit.ly/audacityinstructions 

Audacity is available for both Mac and Windows. 

Audacity   |  www.audacityteam.org   |  $free 

BOTTOM LEFT: RECORD
TOP LEFT: PAUSE, PLAY, STOP, SKIP TO START, SKIP TO END.
TOP RIGHT: TOP ROW - SELECT, ENVELOPE (CHANGE VOLUME), DRAW. BOTTOM ROW - ZOOM, 
TIME-SHIFT, MULTI-MODE.
BOTTOM RIGHT: SELECT MICROPHONE. 

©	Andrew	Douch	2019	 9



Recording Audio Podcasts on iOS, Android or web using 
Anchor
Anchor is a relatively new podcasting platform available on both iOS and 
Android.  

Anchor makes it easy to record a podcast right from your phone, or 
computer and upload it to everywhere podcasts are distributed, including the 
iTunes podcast directory and Spotify.  

Anchor is able to be free because it is possible for listeners to donate money to you through the 
anchor platform. If they do, Anchor takes a cut of the donation.  

One great feature of Anchor is that listeners can submit questions to you through the platform.  

Anchor   | iOS App Store, Google Play Store, Anchor.fm  |  $free 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Recording Audio Podcasts on Android using 
SoundCloud
Clyp (see previous section) is not a good choice for Android users. 
The Good news is that the SoundCloud app for Android includes a 
basic voice recorder, which is almost as simple to use as Clyp, but 
has the added advantage, that your recordings are saved to 
SoundCloud which provides an RSS feed for your students so they can subscribe to your podcast.  
That is a huge advantage over Clyp, because it allows students to listen in their podcast app of 
choice. 

Like the free version of Clyp, SoundCloud’s free tier allows a total of 3 hours of recordings.  After 
that, you can either delete old episodes or upgrade to “Pro” for US$16 per month. 

SoundCloud gives some basic editing options, too.  

Once you have created a free SoundCloud account, opening the app on your Android device and 
starting a recording is straightforward. 

SoundCloud   |  Google Play Store   |  $free / $16 per month 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Recording Audio Podcasts on iOS using 
AudioCopy + SoundCloud
SoundCloud’s app on iOS does not contain a record function. Fortunately 
this shortcoming is easily overcome using another free app: AudioCopy.  

The functionality and feel of AudioCopy is very similar to that of the 
Android version of Soundcloud. You simply press record, speak your words 
and then press stop. Once you have done that you can send the audio to your 
Soundcloud account.   

The only way in which this is a 
disadvantage for iOS users, is 
that it’s an extra step to set it up 
in the first place. You have to 
create a Soundcloud account, 
and then in AudioCopy, you 
have to enter your Soundcloud 
account details so the app can 
post to your SoundCloud 
account. It takes an extra few 
minutes to set up - but once 
that’s done, it’s just as easy and 
just as good. 

To set up your RSS feed 
address in SoundCloud, log into 
your SoundCloud account on 
your computer, click the ellipsis 
icon (…) at the top right of the 
screen, and select “Settings”.  
Then click the “Content” tab 
within the “Settings” window.  

You can fill in the fields if you 
want to (I suggest you do), and MAKE SURE TO TICK the small box labelled “Include in RSS 
feed”.  It won’t work if you don’t tick that box.  I have included below a screenshot of my own 
Content Settings.  Copy the RSS feed and share that with your students. 

AudioCopy   | iOS App Store   |  $free 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End-To-End Podcasting 
Opinion and SoundCloud
Opinion is a fantastic podcasting option for teachers. It is very easy to use and remarkably feature-
rich. It allows you to: 

• record your voice using 
the built-in microphone, 
or an external 
microphone.  

• edit your recordings after 
you have recorded. 

• bring in audio from other 
places on your iOS 
device such as from 
music in the Music app, 
audio files saved in your 
Dropbox folder or 
iCloud Drive.  This 
means, for example, you 
can bring in some music 
created in GarageBand 
Live Loops, to use as an 
intro to your podcast.  

• add a title and 
description of the 
episode. 

• add a picture from your camera roll to serve as cover art. 

• publish your podcast, direct to the internet from the app.  

• download the podcast to to your device to share in other ways. 

A basic account is free, but I would recommend paying the freemium price of $6 for unlimited 
recording time. 

NOTES:  
If you record with an external microphone, you will need to disconnect it to hear the playback of 
your podcast. 

Opinion is not a multi-track editor. Therefore all audio is arranged sequentially and one recording 
cannot overlap another. For example you cannot talk over music. If you want to do that on iOS, I 
recommend GarageBand or BossJock.   
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PUBLISHING YOUR PODCAST 
You can export your podcast to any podcast server.  There are many excellent services available. If 
you don’t already have a podcast server, try SoundCloud. It is free and works very well with 
Opinion. 

First you will need to create a free account at soundcloud.com and 
download the SoundCloud and SoundCloud Pulse apps on your 
phone.  Once you have done this, log in to your SoundCloud account 
on those apps.  

Now, when you press the ‘share sheet’ button in Opinion (the third and last button on the Opinion 
tool bar at the top of the screen), you will be able to choose to share your podcast to SoundCloud. 

The best thing about using Opinion in combination with SoundCloud (or other similar service)  is 
that it provides an RSS feed for your podcast, so that students can subscribe to your podcast from 
the Podcasts app (or another Podcatcher app) on their phone, tablet or computer. That way, when 
you make a new episode, your students’ will receive it automatically.  To set up your RSS feed 
address, log into your SoundCloud account on your computer, click the ellipsis icon (…) at the top 
right of the screen, and select “Settings”.  Then click the “Content” tab within the “Settings” 
window.  
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You can fill in the fields if you want to (I suggest you do), and MAKE SURE TO TICK the small 
box labelled “Include in RSS feed”.  It won’t work if you don’t tick that box.  I have included below 
a screenshot of my own Content Settings.  Copy the RSS feed and share that with your students.

 

Opinion   |  www.madewithopinion.com   |  $free/$6 
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Make your own Podcast Jingles
GarageBand Live Loops 

If you or your students are going to make a podcast and publish it to the internet, you either need to 
use royalty free audio, get permission to use copyrighted material, or make your own music. Up till 
recently, making your own music was out of the question for most of us. But Live Loops changes 
that.  

 

Live Loops is a feature found (only) in the most recent few updates to Apple’s GarageBand app for 
iOS.  If you don’t see it in your version of the app you will need to update to a newer version.  

Live Loops is remarkable. You don’t need to know anything (at all! - literally) about music to make 
original, cool-sounding musical compositions in various styles of music that you can use in your 
creative projects, copyright-free. 

You simply choose a genre (Rock, Reggae, Jazz, House, Dubstep, etc) then select any combination 
of the loops in the soundboard.  It really doesn’t matter what you choose, you can’t make it sound 
bad! You can change loops mid-stream, just by tapping on them, but even if you tap a loop at an 
inappropriate time, it will wait a few seconds then start so that it matches the beat of what you 
already have playing.  

You can record what you play, and since your recording is an original composition you have the 
rights to use it as a jingle in your podcast. Export it to Dropbox as an m4a file, and import it to 
BossJock Studio or Opinion!  

GarageBand   |  www.podomatic.com   |  $12 (free with new iPad) 



Setting up a proper podcast Feed
RSS with Podomatic.com
If you make a podcast, I would highly recommend syndicating your podcast so that people can 
subscribe to it using a “podcatcher” such as iTunes on a computer or any Podcast app on a mobile 
device. The advantage of doing this is that your students don’t have to constantly check if there is a 
new episode to download, nor wait for it to download.  Instead, they can set up a notification for 
new episodes, then simply stream them or set or set up their app to download them automatically in 
the background!  For this purpose I use podomatic.com, which makes publishing your podcast as 
simple as 1, 2, 3 (4, 5)! 

Using Dropbox to share your podcast is certainly easy - but it is also fairly limiting.  For example, 
you can’t add any additional notes to your podcast, a pretty picture to serve as album art.  Also if 
your audio file is large, Dropbox will not do anything to optimise it.   

A better solution is Podomatic. www.podomatic.com.  It takes a bit more setting up than JustCast - 
but it’s still very easy, and has lots of features that allow you to change the way your podcast looks 
and behaves.  

Once you have a free Podomatic account, adding new podcast episodes to it is a simple 4-step 
process.  	

Podomatic   |  www.podomatic.com   |  $free/tiered pricing plan 
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Publishing your Podcast to your Students’ Devices
RSS with JustCast 
The easiest way I know to push your podcast out to all your students’ devices, is to create an RSS 
feed from Dropbox (If you don’t have a Dropbox account, sign up for free at http://
www.dropbox.com).   

Step 1. In your web browser, go to JustCast (http://justcast.herokuapp.com). Click the Get Started 
button and give JustCast permission to create a JustCast folder in Dropbox. 

Step 2.  (Still on the JustCast page), click the “Share” button and copy the RSS feed address (give 
that to your students - they will need to type it into the Podcast app on their device).  

Step 3. There is no step 3.  You’re done!  Now if you want to share a podcast (or any audio) with 
your students, simply put it in the JustCast folder in Dropbox: You’ll find that in Dropbox > Apps > 
JustCast > example. 

It’s so easy I can’t believe it works.  Yet it does.  A free JustCast account lets you have up to three 
audio files shared at one time. 

JustCast   |  JustCast.herokuapp.com   |  $freemium 
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Record Interviews for your Podcast
TapeACall
TapeACall is an iPhone/Android app that allows you to record both outgoing an incoming phone 
calls. You simply open the app, tap the + button, then tap the merge calls button. TapeACall creates 
a conference call between you, the person you are talking to and a private server, which records the 
conference call. After the call is finished, the app downloads the recording from the server so that 
you have the recording on your phone. From there you can export it to Dropbox, from which it can 
be loaded into BossJock Studio, Opinion or another podcasting app. The recording can also be 
exported to Facebook, Twitter, Google Drive, Evernote or Mail.  (I would recommend using 
Dropbox however because that makes it simple to bring it into other apps such as BossJock Studio 
(which allows importing from Dropbox but not Google Drive, for example). 

TapeACall   |  App Store   |  $10.75 per year 
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Getting great sounding recordings using 
The Blue Yeti Microphone
The Yeti Microphone by Blue, is an excellent podcasting microphone, that has a simple USB 
interface.  Unlike most USB microphones though, it has built-in gain control, a variable pickup 
pattern, and a 3.5 mm headphone jack, which allows you to plug in headphones or earphones. 
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Cheaper, more portable, iOS friendly - STill Great.
The Samson Go Microphone
The Samson Go is not as flexible (or quite so capable) as the Blue Yeti, but it costs $100 less (about 
$79) and is small and portable. It can either stand on your desk or clip onto your laptop lid, or iPad.  
When traveling, the microphone folds down into it’s stand, which then acts as its case - ingenious. 

Because it draws significantly less power than the Yeti, it can also be used to record on an iPad 
(with the Apple lightning-USB adaptor that comes as part of the camera connector kit).  

Although small and fairly inexpensive, the Samson produces very good results - not as great as 
you’d get from a Blue Yeti, Rhode Procaster or Samson Meteor, but surprisingly good - and 
certainly much better than you will get from the built-in microphone in your laptop computer. 

While the Samson Go works great with an iPad or iPhone, If you are looking for a microphone for 
that purpose alone, there is a growing range to choose from, which have a lightning plug built right 
in. If you search google for iPhone external microphone you will find a dozen or so. Apple sells a 
few as well (if you want to stick to the Apple-endorsed brands). One such microphone which gets 
excellent reviews is the Shore MOTIV MV88 (pictured below). At $250 it’s not cheap, but it 
obviates the need to use a lightning to USB adaptor and USB cord the way you do with the Samson 
Go. 
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Making Compelling Slides for Screencasts 
The first thing most teachers do when they are asked to give a presentation, is to open PowerPoint or 
some other slide-ware application, and start creating slides. 

It is much more effective to plan in analogue. Before creating any slides, start brainstorming, create a 
set of notes, draw a concept map or flow diagram. Thinking this way is much more effective because it 
helps you to identify the key points that you will present, before you get distracted by slide themes, 
bullet-points and animations.  

Begin by identifying the one central point of your presentation. Ask yourself what you would say if 
you were only given three minutes to speak. This central point is important because later you may well 
find that you have to eliminate material from your presentation and knowing what your main point 
is, will help you to choose which parts to leave out, because they don’t strongly support your central 
point. If you don’t really know what your central point is, then your talk is likely to lack focus and 
direction and it will contain too much “stuff” that doesn’t take the audience in any specific direction. 
In most cases, the title of your presentation will ultimately reflecting your main point. That is as it 
should be. 

As you are planning your presentation, build in a sense of story.  Depending on the presentation 
topic, you may actually tell stories in your presentation, but if not, consider adding elements of story 
to your presentation, no matter what the topic. Our brains have evolved to think in stories and we 
find them naturally engaging and appealing 

Once you have identified your main point, divide the content of your presentation into three main 
sub-topics (or three “acts”). If you have many things to talk about, divide each subtopic into three as 
well. 

There is something about the number 3 that works very well in a presentation. If you divide your 
presentation into threes, you will find that it is more satisfying and memorable to your audience. This 
goes for giving examples, too. You may have 5 examples of a particular point that you are making. You 
will be best to eliminate two of them, leaving just the three best examples. It is hard to do this, but 
your audience will find your examples more memorable if they are in a three-pack. 

One of the key elements of any story is a natural rhythm of tension and release. This may take the 
form of posing a problem or question, and then answering it, before posing another question and 
answering that, and so on. You may raise a curious question at the beginning of your presentation, 
and promise to resolve it at the end (with a twist, perhaps, to leave your audience reeling from the 
surprise!). 

Almost all good stories have a villain or adversary. Find one for your presentation. The antagonist will 
help the audience to rally behind you (their conquering champion). If you are trying to show why 
something is good or important, your message will be more effective if there is something opposing it, 
something to compare it to. 
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There was a time when we were impressed by what computers could do. PowerPoint presentations 
with movement and sound effects and cool slide transitions were all-the-rage. It’s 2013 now, and 
nobody is really impressed by that any more. I think it’s better to leave it out, unless the motion is 
illustrative in some way. If the motion helps you to tell your story, then it is good. But if it is simply 
movement for the sake of movement it is distracting and will detract from your message. Cut it out, 
no matter how cool it looks to you. This is the main reason I don’t use Prezi. 

The same can be said for images. If your slide contains graphics that are illustrative, if they evoke 
mood, if they help you to tell your story then they are great! But many PowerPoint slides I see have 
template designs with swooshes of colour or floral patterns or some other design element that does 
nothing to enhance the message. It would be better to have a plain black slide with white text, because 
that will not detract from your message. 

Slides are much more effective when they don’t contain too much text. In a document the text tells 
the story and needs to be there. In a presentation, you tell the story! The slide is there to support you 
as you do so. Putting text on the screen is counterproductive. Psychologists report that people are less 
able to understand information if it is presented in both verbal and written form at the same time! 
(Cognitive Load Theory). 

A sentence, a title, a quote - these can be very effective. A paragraph of text however is not effective.  If 
you have a lot of written information that you want the audience to take away and read later, put it in 
a text document (like I am doing here!). But when you stand up to speak, don’t put the text on the 
screen. At best it’s boring. At worst it compromises your message. 

Most presentations include slides with long lists of bullet-points. It’s no wonder they do, because 
when you create a new slide in PowerPoint or Keynote, the default slide is a bullet-point slide which 
beckons you to start filling in the points! My advice is not to use bullet points at all - unless you are 
making a true list. A true list is a list of items which you want the audience to see all at once because 
each is more effective if it is seen in combination with the others in the list. If on the other hand, you 
simply have five things to say about a topic, don’t use one slide with five bullet points; use five 
separate slides. There are a number of reasons for doing this. Firstly, your slides will look much nicer. 
This is especially true if you use large, high quality images that illustrate the point you are making and 
help your audience to make an emotional connection to the point. Secondly, they help the audience 
to focus on the single point you are making as you are making it.  

No doubt the reason we tend to put lots of information on one slide is because we grew up making 
text documents and we didn’t want to waste paper, so we put lots of information on each page to 
reduce the page count. That doesn’t matter at all in a presentation - so go ahead, be as wasteful as you 
want! 

Consider the colours and colour combinations you use on your slides. There are no hard-and-fast 
rules about what colours to use, but you should take the time to consider how the colour you have 
chosen will make your audience feel. Will it enhance your message or work against it? 

Likewise, carefully consider the fonts you use on your slides. Typically serif fonts (like the one you are 
reading now) are more legible when you are reading lots of text on a page. This is not true on a 
computer screen though, and besides, your slides don’t contain much text, right? So readability (that 
is the ability to read the text fast) is not very important on a slide. What is important is what message 
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your choice of typeface conveys to the audience. You should consider what it might remind them of - 
have you seen a similar font in a particular company’s advertisement, for example? One of the most 
important things to remember here, is that you are not choosing a font because you like the way it 
looks, or because it is cool or funky or unusual. Your choice of font should be based on whether it 
helps you to tell your story. If the font you choose enhances your message, then it is a good choice. If 
it is distracting, it is a bad choice no matter how nice it looks.  

Also never use Comic Sans or Arial as these fonts are reviled by many. Papyrus and Marker Felt are 
hated almost as much. 

One way to get high quality, royalty-free images is to form the habit of taking photographs of things 
when you see them. You will be surprised how hand this is. Other sources of high quality images 
include:  

•www.morguefile.com 
•www.unsplash.com 
•www.pixabay.com 
•www.pxhere.com 

•search.creativecommons.org 
•commons.wikipedia.org 

•www.istockphoto.com 
•www.shutterstock.com 

Images look much nicer when you adhere to the “Rule of Thirds”. If you divide your slide into three 
both horizontally and vertically, then place the key elements of your slide on the intersections 
between the (imaginary) lines, they will look much more balanced and powerful than if you place 
objects randomly on the slide. Photographers and artists have known about this since ... forever! But 
it applies just as much to slide design as it does to painting a landscape. 

When creating your slides, pay attention to negative space (or ground) not just to the objects you are 
putting on the slide (the figure). In Gestalt theory, the ground is just as powerful as the figure. Leave 
plenty of space around objects (look at the slide above for example). It’s tempting to fill every inch of a 
slide, but it’s much more powerful, and the images and text you do put on the slide will be that much 
more effective, if you leave lots of “ground” around them.  

The gestalt principle of continuance, suggests that your slides will be more powerful if the images you 
include, lead the eye toward the most important elements on the slide. This may be to the text or 
heading on the slide. Again, notice the image above and how the scientist’s gaze, and forward-leaning 
posture leads our eyes to the quote. The image right is another good example of the principle of using 
continuance. We immediately look at the dancer, but then our eyes follow his body up toward the 
title, and quote. 

A third aspect of gestalt theory deals with “closure”. When you see part of an image - especially if it is 
a familiar image, your brain fills in the missing parts of the image. By deliberately cutting off part of 
the image, the mind perceives the image to be much larger and more dynamic than if the entire image 
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was shown. It is almost as though the image is so large and vibrant that the slide cannot contain it. 
Consider the two slides below. In each I have used the same photograph, the same text in the same 
font, but by cutting off most of the house and flames, the viewer feels much more involved with the 
subject of the picture. 

As a general rule, it is not a good idea to include faces in your slides - unless of course the point of the 
slide is the face you are showing. Our brains are highly attuned to human faces. When you look at a 
slide that has a face on it, you instinctively look at the face to the exclusion of the rest of the slide. If 
the face is not the important part of the slide, then having it there will detract from your message. 
When you look at a slide with both a face and some important information, (observe yourself) you 
naturally look at the face first, then the text , then back to the face and that is where your attention 
stays. With other objects, you tend to look at the object, then the information - which is where your 
focus rests. That is much more effective. 

The use of animation should also be used sparingly, and purposefully. All presentationware tools 
including Keynote and PowerPoint have ways to animate text, slide transitions, etc. These can 
sometimes be useful, but are rarely impressive anymore.  

Three animation effects that are often very useful, and are quite impressive are described below.  

1.  Create a blurred version of an image. Introduce the slide with the original image, then have that 
image “fade” or “Dissolve” leaving a blurry version of the same image, onto which you introduce 
any text to the slide. This not only looks cool, but also focuses the attention of the audience on 
the text, while keeping the supporting image in their mind. To do this, place the image on the 
slide and make it blurry, by clicking on the image, then in the PowerPoint toolbar click the 
“Artistic Effects” button and choose “Blur”.  If the image has not been blurred enough, click on 
the “Artistic Effects” button again, and choose “Artistic Effects Options”. Then in the window 
sidebar on the right, drag the “Radius” slider to increase the blur effect.  Next type your text on 
top of the blurry image (in a text box).  Finally place the same image (a non-blurry version of it) on 
top of the slide. Then click the “Animations” tab in PowerPoint and set an exit animation to 
“Fade”.  In this way, while showing your slides, when you click, the clear version will fade out 
leaving the blurry version and some text.  It’s very effective. 

2. Embed an automatically playing video on an image, within a slide. This creates a great illusion 
that the image is ‘alive’, without being too distracting. To do this, you first need to make one part 
of the image transparent (see next section). Then place the image on top of a video on a 
PowerPoint slide and your audience will see the video playing through the transparent sections of 
the image. It helps if you click on the movie, click on the Playback tab, and change the playback 
mode from “In click sequence” to “Automatically”.  That way, when you advance to that slide, the 
movie will already be playing. 

3. Path animations. In PowerPoint, an element on a slide can be instructed to move around a slide, 
following a path which you can draw with your mouse.  To do this, click on the object to select it, 
then click the Animations tab in PowerPoint, Find the Path Animations section and within that 
choose the “Draw Scribble” or “Freeform Path” or “Draw Path” (it has different names in 
different versions of PowerPoint.  Then draw the path that you would like the object. 
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Advanced Image Editing

Adobe Photoshop 
Adobe Photoshop has been around for decades and is the industry standard image editor. It is, 
however very expensive at $14 per month! That’s a justifiable expense if you are a professional 
photographer or image editor. For a teacher however, given that you may only use it occasionally it’s 
more than most are willing to pay.  

Serif Affinity Photo 
Serif Affinity Photo is a viable alternative to Adobe Photoshop and at $62 (one time purchase) it is a 
fraction of the cost.  

My Advice on which to buy 
I have both Photoshop and Affinity Photo, but I have quite quickly moved to using Affinity Photo for 
almost everything that I used to do with Photoshop. There is just one thing that I can do easily with 
Photoshop that doesn’t work nearly as well in Affinity Photo (Mockups/Smart Objects). Everything 
else I need to do I can do just as well in Affinity Photo, and there are several things I do often that are 
much faster and easier in Affinity Photo than they are in Photoshop! If you plan to pay for an 
advanced image editor, my advice would be to go with Affinity Photo. You can download a free trail 
of each of them though, so you have nothing to lose by putting them through their paces to see which 
works for you best. 

Advanced Image Editing Techniques 

Removing unwanted objects from photos 
Both Photoshop and Affinity Photo have the ability to remove objects from photos and patch the 
background so that it looks like the object was never there.  

In Photoshop, you choose the ‘Spot Healing Brush’ tool from the tool bar on the left (if you hover 
your mouse over the tools it will name each in turn). In Affinity Photo, you use the “Inpainting Brush 
Tool” which is in a submenu that opens when you click the Healing Brush tool on the left hand side 
(It looks very much like in Photoshop). Once you have found the tool (that was the hard part), paint 
over the object you want to remove, and then wait a few seconds and like magic it disappears!  

Note: you can change the brush size by pressing the [ and ] keys on your keyboard.  

Making one part of a slide focussed and others blurry 
To lead your students’ eyes to the part of the slide you want them to look, you can blur all parts of the 
slide except where you want them to look. This can easily be done in either Photoshop or Affinity 
Photo. In Photoshop choose Filter > Blur > Iris Blur. Then move the iris to where you want the point 
of focus to be. (It’s pretty obvious when you see it).  In Affinity Photo you do exactly the same thing, 
except the tool is called “Depth of Field Blur”. 
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Make parts of images transparent 
This is one of the most compelling reasons to pay for a professional grade image editor. While you can 
make parts of an image transparent in PowerPoint using the “Remove Background” tool as described 
on page 10, or in Keynote using the “Instant Alpha” tool in the Image tab. But these will only get you 
so far. It’s OK for a solid, smooth-edged object like a TV screen, but if you try to select around a 
person’s head, their hair will look like it’s been chopped out crudely with scissors.  

Both Photoshop and Affinity Photo are amazing at this. First you select your object using any of the 
selection tools (Usually I use the “Quick Selection Brush” tool in Photoshop or the “Selection Brush” 
tool in Affinity Photo. They do the exact same thing. Alternatively you can select around the object 
using the “Lasso Tool” (Photoshop) or the “Freehand Selection Tool” (Affinity Photo).  Often for very 
fine jobs I choose the Polygonal Lasso Tool (Photoshop) which is in a submenu when you click and 
hold on the Lasso Tool icon.  In Affinity Photo there is no polygonal lasso tool. Instead, you hold the 
shift key on your keyboard when using the Freehand Selection Tool. It does the same thing as 
Photoshop’s Polygonal Lasso tool.  

However you select your object, you don’t have to be ultra precise about it. When you have selected 
the object, click the “Refine Edge…” / “Refine…” button above your photo. You can then paint 
around the edge of your object to refine the selection. It’s really quite something! 

One your software does its magic, in Photoshop click the “Decontaminate Colours” checkbox before 
clicking “OK”.  In Affinity Photo, change the Output menu from “Selection” to “New Layer with 
Mask”, then “Apply”. 

To use the image you have now created with a transparent area, you must export the image as a PNG 
file. In Photoshop go to File > Save As… and change the format to PNG. In Affinity Photo, go to File 
> Export and choose PNG (which is probably set already for you).  

Perspective and Distort 
If you want an image to be tilted/angled on a slide. You can do this easily.  

In Photoshop, go to Edit > Transform > Distort. Then drag the corners of the shape to wherever you 
want them to be.  

In Affinity Photo, click the small Perspective tool on the left (second from the bottom). If the “Mesh 
Warp Tool” is in that position, click and hold that and in the pop-up menu that appears, change it to 
“Perspective Tool.”
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